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Disclaimer 

	 Flex2D is distributed on an as is basis without any warranty, explicit or implicit. The 
author will not be liable for direct, indirect, incidental, or consequential damages resulting 
from any defect in this software or in this user's manual, even if he has been previously 
been made aware of the defect. Furthermore, I make no systematic effort to inform all 
users of either bug fixes or upgrades. This program may not be sold or offered as an 
inducement to buy any other product.


Flex2D is free for academic, non-profit purposes. If you want to use the program for 
commercial purposes, please contact me at nestor.cardozo@uis.no.


Referencing this program 

	 Please reference the program as: Flex2D by Nestor Cardozo.


Credits 

	 The plots in Flex2D rely on the SM2DGraphView Framework by Snowmint Creative 
Solutions. Formulas and algorithms are from Hetenyi (1946) for the case of an elastic 
beam of constant thickness, and Bodine (1981) for the case of an elastic beam of variable 
thickness. I would like to thank German Ojeda for sharing Matlab scripts for Bodine's 
solution. A short description is given in the Formulas section.


Introduction 

The displacement profile of the surface of the Earth under crustal loads (i.e. 
mountain chains), can be reasonably reproduced by an elastic or flexural model. In this 
model, the uppermost layer of the Earth (i.e. the elastic lithosphere) responds to crustal 
loads as an elastic beam, floating in a weaker, fluid-like foundation (i.e. the astenospheric 
mantle) (Turcotte and Schubert, 1982; Watts, 2001).
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	 This simple flexural model provides insight into how tectonic loads (i.e. mountain 
chains) and sedimentary basins are linked, and how the crust and mantle support loads. 
The use of the flexural model has allowed geologists to understand the regional variations 
of strength of the lithosphere, and the implications that these variations have for mountain 
building, sedimentary basin formation, and earthquakes (Watts, 2001).


	 Flex2D is a program that implements the elastic flexural model. Crustal loads can 
be entered and plotted, the profile of deformation produced by these loads can be 
computed and visualized, and the effect of changes in model parameters can be 
evaluated. Geologists often talk about the link between tectonic loads and sedimentary 
basins, but they rarely do the math. Perhaps, because implementing the flexural model is 

tedious, specially if done in a spreadsheet. Flex2D makes flexural modeling easy.


Conventions 

	 There are four parameters that define a load column in Flex2D. These parameters 
can be entered in the table of the Loads view (Figure 1):
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Figure 1. The Loads view and entering a load column



	 For each load column, it is necessary to input:


1. xmin = The x coordinate at the left side of the column in kilometers.

2. xmax = The x coordinate at the right side of the column in kilometers

3. h = The column height in meters

4. ρ = The column density in kg/m3.


	 The x coordinate at the right side of the column should be higher than the x 
coordinate at the left side of the column, otherwise the load is not plotted and not 

included in the computation. Please notice that when the broken beam solution is 

selected, loads with x coordinates lower than zero are not considered in the 

computation. The load height can be positive or negative. Notice that the x coordinates 
(distance) are given in km while the y coordinates (height) are given in meters. The load 
density ρ should be positive. The meaning of each column in the Loads table can be 
observed by placing the mouse over the column labels (each label has a help tip 
associated to it).


	 There are five parameters that define the flexural model:


1. E = The Young Modulus of the elastic lithosphere in GPa (1e9 Pa).


2.  = The Poisson ratio of the elastic lithosphere. This parameter is dimensionless 

and it should be ∼0.25.


3. The elastic thickness in km. This is the thickness of the outmost layer of the Earth 
that behaves elastically (i.e. the elastic lithosphere). This thickness can be constant 
or variable along the profile (see the Interface section).


4. ρf = Density of foundation in kg/m3. This is the difference between the density of the 
mantle and the density of the material filling the basin.


5. xint = The x interval of computation in km. In Flex2D the profile is divided in intervals 
of length xint. The deflection is computed at these intervals.


	 These parameters can be set through the Inspector panel (see 
the Interface section). 

ν
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	 In the table of the Flexure view, the resultant topography t is reported 
in meters above sea level, and the downward displacement u in meters (Figure 
2). Positive and negative values of u indicate downward and upward displacement, 
respectively. The meaning of each column in the table of the Flexure view can be 
observed by moving the mouse over the column labels (each label has a help tip 
associated to it).


 

Density of the foundation 

• If the resultant depression is not filled with any material, ρf should be equal to the 
density of the mantle ρm.


• If the resultant depression is filled with water of density ρw, ρf should be equal to      
(ρm - ρw).


• If the resultant depression is filled with sediment of average density ρs, ρf should be 
equal to: (ρm - ρs).
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Figure 2. The Flexure view



Infinite or broken beam: 

	 There are two types of solutions in Flex2D: Infinite beam, and broken beam. In the 
infinite beam solution, the elastic beam extends infinitely along the x axis. In the broken 
beam solution, the beam has a free end at x = 0, and extends infinitely in the positive x 
direction. Since the free end of the broken beam is at x = 0, loads with x coordinates 
lower than zero are not considered in this case. The type of beam, infinite or broken, can 

be set through the Inspector panel (see the Interface section). By default, Flex2D uses the 
infinite beam solution. 

	 The elastic thickness can be set constant or variable and its value(s) can be edited 

in the Inspector panel (see the Interface section). By default, Flex2D uses a constant 
elastic thickness.


Interface 

	 Flex2D consists of two views: 1. A Loads view, and 2. A Flexure view. You can 
choose any of these views by either clicking the tabs on top of the window, using the 

Modules menu, or typing ⌘1 or ⌘2 for the Loads or the Flexure view, respectively.


Flex2D is a document-based application. You can open as many documents as you 
want; each will contain its own analysis.


The Loads view 

	 In the Loads view (Figure 3) you can enter and visualize the loads. You can add or 
remove loads by either clicking the Add or Delete buttons, choosing the Add or Delete 

submenus in the Loads menu, or typing ⌘= (add) or ⌘- (delete). For a description of the 

parameters needed for defining a load see the conventions section. When entering the 

loads, you can undo (Undo submenu in the Edit menu or ⌘Z) or redo (Redo submenu in 

the Edit menu or ⇧⌘Z) changes.
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	 You will notice that the program by default automatically draws the loads if they 
have been entered correctly (see the Conventions section). This behavior can be changed 
in the Preferences panel.


Adding loads from the pasteboard or a text file 

	 If you find annoying entering loads in the Loads table, you can import the loads 
from the pasteboard or a text file. Open a text editor or a spreadsheet program. Enter the 

loads as in Flex2D. If in a text editor, use spaces, commas, or tabs to separate the entries 
of a load, and the return key to start a new load. When finished, you can either copy the 
contents of the file and paste them in to the Loads table, or save the file as a text file (txt 
extension). Then you can drag the file into the Loads table. If entered correctly, the loads 
will be added to the Loads table. 


	 You can save the loads by either choosing the Save submenu in the File menu, or 

typing ⌘S. The program will create a file with extension flex2d.
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Figure 3. The Loads view with a collection of load columns



Flexing the profile 

	 Once the loads are entered, you can flex the profile by either clicking the Flex 

button, choosing the Flex submenu in the Units menu, or typing ⇧⌘F. The program will 

automatically switch to the Flexure view and show the deformed profile. Notice that 

Flex2D does not automatically update the Flexure view according to changes in the 
Loads view. To update the Flexure view you will need to flex the profile.


The Flexure view 

	 Before applying the loads, the Flexure view is not very exciting. It just shows a 
blank graph and a table without data (Figure 2). When you flex the profile (click the Flex 
button, or choose the Flex submenu), the program automatically chooses the Flexure 
view. Both, the deformed topography (by default black) and the displacement profile (by 
default red) are shown in a graph and in a table (Figure 4). In the table, the rows for the 
maximum (basin axis) and minimum (forebulge) deflection are shown in red and blue 
respectively. 
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Figure 4. The Flexure view after flexing the profile



	 You can toggle on and off the topography and deflection curves using the buttons 
below the table. You can move the mouse over the Flexure graph to see its coordinates.


 Changing parameters and editing plots 

	 You can set the model parameters, edit the graphs, or change the properties of 
lines in the plots using the Inspector panel ( Inspector submenu in the Tools menu, or key 

combination ⇧⌘I). The model parameters can be set in the Parameters view, the plots 

parameters can be changed in the Plot view, and the properties of lines can be set in the 
Lines view of the Inspector (Figure 5).


	 In the Parameters view, you can set the type of solution: Infinite or broken 
beam. The infinite beam solution uses an elastic beam that extends infinitely along the x 
axis. The broken beam has a free end at x = 0, and extends infinitely in the positive x 
direction. When the broken beam solution is selected, loads with x coordinates lower than 

zero are not considered. Flex2D uses by default the infinite beam solution.


	 In the Parameters view, you can also specify the model parameters: i. The Young 
Modulus, Poisson's ratio, and elastic thickness of the lithosphere, ii. the density of the 
foundation, and iii. the x interval at which the deflection is computed. The density of the 
foundation is the difference between the density of the mantle and the density of the 
material filling the basin. You can set this value to simulate: i. No material filling the 
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Figure 5. The Inspector panel and the Parameters (left), Plot (middle), and Lines (right) views



resultant depression, ii. water filling the resultant depression, or iii. sediments filling the 
resultant depression (see Conventions section). By default the density of the foundation is 
the density of the mantle: 3300 kg/m3. This corresponds to the case of no material filling 
the basin.


	 The elastic thickness can be constant or variable. By default Flex2D uses a 
constant elastic thickness. If you choose the constant elastic thickness option (Figure 5, 
left), you can set the elastic thickness in the corresponding text field. If you choose 
variable elastic thickness, you can input the elastic thickness values along the profile by 
clicking the Edit button (Figure 5, left). This will open a sheet where you can enter the 
elastic thickness by either:  (i) clicking on the graph, (ii) entering points along the profile in 
the table, or (iii) dropping in the table a text file with 2 columns corresponding to the x 
locations and values of elastic thickness (Figure 6).


	 The equations for the deflection of an infinite or broken beam of constant thickness 
are from Hetenyi (1946), and those for beams of variable thickness are from Bodine 
(1981). A short description of the equations is given in the Formulas section.
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Figure 6. Defining a variable elastic thickness along the profile



	 The Inspector is a great way to see the effect of changing model parameters. Input 
the loads, flex the profile, open the Inspector and in the Parameters view change the 
elastic thickness (Figure 5, left). The program will automatically update the flexure graph 
and table for the new elastic thickness. The Inspector can also be used to change the 
extent (horizontal or vertical) of the model (Figure 5, middle).


	 Editing your graphs for publications or presentations is very easy. Experiment with 
both the Plot and Lines views of the Inspector. Notice that you can choose the line (loads, 
topography or deflection) to be modified using the first pop-up button in the Lines view 
(Figure 5, right). Changes in the Inspector affect the selected document. The settings in 
the Inspector are saved to flex2d files. However, only the Input loads and the Inspector 
settings are saved. After opening a flex2d file, you will have to flex the profile to see the 
results.


Saving plots 

	 You can save the plots produced by Flex2D as pdf files. Just choose the Save Plot 
as PDF submenu in the File menu.


Copy and paste 

	 You can drag plots to vector programs, and the content of the tables to text editors 
and spreadsheets. You can also drag these elements to the Finder to make a pdf of a 
plot, or a text clipping of the selected data. You can also copy and paste table data (e.g. 

to a spreadsheet) using the copy (⌘C) and paste (⌘V) submenus.


Preferences panel 

	 You can set whether or not the program draws the loads automatically or open a 
new document at launch, through the Preferences panel (Figure 7).


Formulas 

	 In the flexural model, the uppermost layer of the Earth responds to crustal loads as 
an elastic beam, floating in a weaker, fluid-like foundation (i.e. the astenosphere) (Turcotte, 
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1982; Watts, 2001). The solution for this problem is the same as the solution for an elastic 
beam on an elastic foundation. If the thickness of the beam is constant, the solutions for 
and infinite or broken beam are given by Hetenyi (1946):


Infinite beam 

	 The infinite beam extends infinitely along the x axis. The procedure to compute the 
deflection produced by a load column on the beam is as follows:


1. Use the flexural rigidity  to express the strength of the lithosphere (i.e. elastic beam):


	 (1)


where  is the Young’s modulus,  is the Poisson’s ratio, and  is the elastic thickness.


2. Invent a term  :


	 (2)


where  is the horizontal coordinate and  is a length parameter given by:


	 (3)


where  is the density of the foundation. This is the difference between the density of the 

mantle ( ) and the density of the material filling the basin.  is gravity.


3. The deflection  of any point along the beam is equal to:


D

D =
ETe3

12(1 − ν2)

E ν Te

D(α,x)

D(α,x) = exp(−x /α)cos(x /α)

x α

α = [ 4D
ρf g ]

1
4

ρf

ρm g

u
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Figure 7. The Preferences panel



a. If the point is under the load column:


	 (4)


b. If the point is to the left of the load column:


	 (5)


c. If the point is to the right of the load column:


	(6)


where ,  is the height of the load column, and  is the load density.  and  are 

measured as absolute distances from the point to the left and right borders of the load 
column, respectively.


Broken beam 

	 The broken beam has a free end at x = 0 and extends infinitely in the positive x 
direction.The deflection of this beam is obtained by first considering the forces that are 
generated during bending of an infinite beam, and then "nulling" the bending moment and 
shear force at the free-end x = 0. The procedure is described in detail by Hetenyi (1946):


1. Introduce new terms ,  and :


	 (7)


	 (8)


	 (9)


2. Compute the moment and shear force at x = 0:


	 (10)


	 (11)


where  and  are the distances from x = 0 to the left and right side of the load column, 

respectively.


u =
q
2k

(2 − D(α,a) − D(α,b))

u =
q
2k

(D(α,a) − D(α,b))

u = −
q
2k

(D(α,a) − D(α,b))

q
k

= h
ρ
ρf

h ρ a b

A(α,x) B(α,x) C(α,x)

A(α,x) = exp(−x /α)(cos(x /α) + sin(x /α))

B(α,x) = exp(−x /α)sin(x /α)

C(α,x) = exp(−x /α)(cos(x /α) − sin(x /α))

M0 =
qα2

4
(B(α,a′￼) − B(α,b′￼))

Q0 =
qα
4

(C(α,a′￼) − C(α,b′￼))

a′￼ b′￼
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3. Compute the moment and shear force required to cancel the moment and shear force 
at x = 0:


	 (12)


	 (13)


To simplify the equations, let’s call the second terms of Eqs. 12 and 13  and :


	 (14)


	 (15)


4. The deflection at any point along the beam is:


a. If point is under the load column:


		 (16)


b. If point is to the left of the load column:


	 (17)


c. If point is to the right of the load column:


	 (18)


Principle of superposition 

	 For an infinite or broken beam, the displacement profile is computed for each load 
column. The total displacement profile is the sum of the displacement profiles of the load 
columns.


Variable elastic thickness 

	 For a beam of variable thickness, the solution for and infinite or broken beam are 
given by Bodine (1981). These solutions are numerical and are based on finite differences. 
The solution for an infinite beam is given by Bodine in his program FMDEPYE, and for a 

MC = −
qα2

2
[2(B(α,b′￼) − B(α,a′￼)) + (C(α,a′￼) − C(α,b′￼))]

QC = qα[(B(α,b′￼) − B(α,a′￼)) + (C(α,a′￼) − C(α,b′￼))]

aa bb

aa = 2(B(α,b′￼) − B(α,a′￼)) + (C(α,a′￼) − C(α,b′￼))

bb = (B(α,b′￼) − B(α,a′￼)) + (C(α,a′￼) − C(α,b′￼))

u =
q
2k

[(2 − D(α,a) − D(α,b)) + bbA(α,x) − aaB(α,x)]

u =
q
2k

[(D(α,a) − D(α,b)) + bbA(α,x) − aaB(α,x)]

u =
q
2k

[(D(α,b) − D(α,a)) + bbA(α,x) − aaB(α,x)]
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broken beam in his program FMDEPYEC. The reader is referred to Bodine (1981) for 
further details about these programs.


	 For the same elastic thickness and load distribution, the Hetenyi and Bodine 
solutions don't give exactly the same results. This is because Hetenyi's solution is 
analytical while Bodine's solution is numerical, and also because in Hetenyi's solution 
loads are entered as columns, while in Bodine's solution loads change continuously along 
the profile. This last difference will be less marked as the width of the columns decreases.
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